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Preparing for the Sage DacEasy Conversion
Sage DacEasy Conversion Guide1
• Preparing for the Sage DacEasy 
Conversion •

Overview
You can easily convert your DacEasy accounting information to Sage 50  
Accounting—U.S. Edition using the DacEasy Conversion wizard. We’ll ask you 
for all of the information that we need upfront, and then we will be able to 
convert your data appropriately.

Because of program differences all information can not be converted. For 
example, transaction detail will not be converted. 

There are steps that you can take to make the conversion process run smoothly. 
We recommend that you read this chapter to learn how to get ready for the 
conversion. We will offer helpful information and tips that will make the 
transition to Sage 50 Accounting run smoothly.
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What Gets Converted and What Does Not?
What Gets Converted and What Does Not?
One major difference between Sage 50 and DacEasy is that DacEasy is a 
modular system that allows you to install individual programs like payroll, job 
cost, and accounting. Sage 50, on the other hand is an all-inclusive accounting 
solution. When you install the product, you have access to everything from 
payroll to job cost to inventory. 

In this section, we will explain what DacEasy information will be converted and 
what will not.

The table below explains what gets converted if you installed the Accounting 
module of DacEasy.

Program 
Area

What Is Converted What Is Not

Company 
Information

• Company Name/Address 
(confirmation required during 
conversion)

• Phone Number 1

• Fax Number

• Federal ID

• State ID

• E-mail Address

• Phone 2

General Ledger • Account Names and Numbers

• Account Group (category names 
may change slightly, as in Current 
Assets becoming Other Current 
Assets)

• Account Activity, by period

• Beginning Balances

• Transaction 
Detail

• General 
Account types
3
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Sage DacEasy Conversion Guide1
Accounts 
Receivable

• Customers, including Names and 
Codes

• Contact

• Bill to Address

• E-mail Address

• Phone Numbers 1 and 2

• Fax number

• Country

• Alternate Customer Addresses (only 
the first 9 will be converted)

• Pricing Level Defaults

• Salesperson, located in Maintain 
Employees/Sales Reps

• Payment Terms

• Current Customer Balances

• Sales Tax Codes

• Custom Fields (only 5 will be 
converted, based on what you select 
in the Conversion wizard) 

• Default Credit Status

• Default Credit Limit

• Default Account Group

• Transaction 
Detail

• Account Type

Program 
Area

What Is Converted What Is Not
4



What Gets Converted and What Does Not?
Accounts 
Payable

• Vendors, including Names and Code

• Contact

• Vendor Address

• E-mail Address

• Tax ID

• Phone/Fax Numbers

• Contract Labor (1099 Vendors)

• Shipping Method

• Vendor Type

• Credit Limit

• Default AP Accounts

• Custom Fields (only 5 will be 
converted, based on what you select 
in the Conversion wizard)

• Terms

• Transaction 
Detail

• Account Type

Program 
Area

What Is Converted What Is Not
5
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Inventory • Item Defaults

• Master Items

• Product Code and Description

• Bin

• Quantity on Hand

• Minimum On-hand Quantity (also 
known as Minimum Stock in Sage 50 
Accounting).

• Reorder Quantity

• Purchase Measure (only for Sage 50 
Manufacturing Accounting, Sage 50 
Distribution Accounting, or Sage 50 
Quantum Accounting)

• Purchase Fraction (only for Sage 50 
Manufacturing Accounting, Sage 50 
Distribution Accounting, or Sage 50 
Quantum Accounting)

• Selling Measure (only for Sage 50 
Manufacturing Accounting, Sage 50 
Distribution Accounting, or Sage 50 
Quantum Accounting)

• Sell Fraction (only for Sage 50 
Manufacturing Accounting, Sage 50 
Distribution Accounting, or Sage 50 
Quantum Accounting)

• Sales price

• Weight

• Price Breaks

• Serial Numbers (only for  Sage 50 
Premium Accounting and higher, 
with some limitations)

• Custom Fields (only 5 will be 
converted, based on what you select 
in the Conversion wizard)

• Transaction 
Detail

• Cost/Standard

• Cost/Average

• Weight Code

Program 
Area

What Is Converted What Is Not
6



What Gets Converted and What Does Not?
Payroll • Employee Code (ID)

• Employee Name

• Address

• E-mail Address

• Phone Number

• Social Security Number

• Termination Date

• Pay Amount

• Overtime 1 & 2

• Federal, State & Local Allowances

• Additional Federal, State, & Local 
Withholdings

• Custom Fields (only 5 will be 
converted, based on what you select 
in the Conversion wizard)

• Vacation 
Accruals

• Sick Accruals

• Payroll year to 
date totals 

Note: You can                   
manually enter year 
to date totals as 
beginning balance 
entries for each 
employee.

Sales Taxes • Tax Code (ID)

• Tax Description

• Tax Rate

• Purchase Tax 
Codes

Jobs • Job Code (ID)

• Job Description

• Job Manager

• Customer Code

• Contract Number

• Percent Complete

• Custom Fields (only 5 will be 
converted, based on what you select 
in the Conversion wizard)

• Phases and Sub-Phases

Program 
Area

What Is Converted What Is Not
7
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Salesperson 
Information

• Salesperson Name and Code

• E-mail Address

Employee #

Territory

Rate

Amount

Program 
Area

What Is Converted What Is Not
8



Detailed Explanation of What Gets Converted
Company Information
Detailed Explanation of What Gets Converted

Company Information

Most company information will be converted or requested during the 
conversion. 

• The company name, address, city, state, zip, and country will be 
converted, but you will be asked to confirm the information in the 
Conversion wizard. 

• Phone number 2 will not be converted because Sage 50 accepts only 
one phone number per company.

• Since DacEasy only uses the Accrual accounting method, all companies 
will be set to Accrual in Sage 50.

• Since DacEasy does not have a field that identifies a company’s form of 
business, you will be allowed to choose business type in the Conversion 
wizard.

Chart of Accounts

In DacEasy, you had two types of accounts, general or detail. General accounts 
were used for rollups. Only detail accounts will be converted to Sage 50.

• Account Group: The Account Group in DacEasy is called Account 
Type in Sage 50. The account group will be assigned to comparable 
account types according to the following table.

DacEasy GL Account Group Sage 50 Account Type

Asset Other Current Assets

Liability Other Current Liabilities

Capital Equity-doesn’t close

Revenue Income

Expense Expenses

Other Credits Equity-doesn’t close

Other Debits Equity-doesn’t close

• If you are converting from the Accounting module and the account is a 
default account, we can further classify the account type, according to 
the following table.
9
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DacEasy GL Account Group Sage 50 Account Type

caAcctNo[0] Cash

caAcctNo[1] Accounts Rec

caAcctNo[2] Accounts Pay

caAcctNo[3] Inventory

caAcctNo[4] Cost of Sales

Defaults

AR Defaults

Most AR defaults will be converted to comparable accounts in Sage 50, with the 
following exceptions or changes.

• Custom fields: You will be asked to select five customer custom fields 
in the Conversion wizard. Custom fields will all be text fields in Sage 50 
and may be shortened if they exceed field limits in Sage 50.

• Terms and Discounts: If Sage 50 handles terms differently than 
DacEasy, the terms will be translated to match Sage 50’s methods for 
calculating terms. For example, in DacEasy you can offer discounts 
based on either number of days or day of the month, while in Sage 50 
you can only offer discounts based on the number of days. Your 
discounts that were calculated based on the day of the month will be 
converted to days. 

• Customer Credit Check Status: Customer Credit Check Status, also 
known as Credit Status in Sage 50, will be converted based on the 
following table.
10



Detailed Explanation of What Gets Converted
Defaults
DacEasy Customer Credit Check 
Status

Sage 50 Credit Status

No-do not notify No credit limit

Warn-warn but allow the user to continue Notify over limit

Enforce—Display error, password override 
possible

Hold over limit

AP Defaults

Most AP Defaults will be converted or requested in the Conversion Wizard.

• Custom fields: You will be asked to select five vendor custom fields in 
the Conversion wizard. Custom fields will all be text fields in Sage 50 
and may be shortened if they exceed field limits in Sage 50.

• Terms and Discounts: If Sage 50 handles terms differently than 
DacEasy, the terms will be translated to match Sage 50’s methods for 
calculating terms. For example, in DacEasy you can offer discounts 
based on either number of days or day of the month, while in Sage 50 
you can only offer discounts based on the number of days. Your 
discounts that were calculated based on the day of the month will be 
converted to days. 

Item Defaults

The majority of your Inventory item defaults will be requested in the 
Conversion wizard.

• In Sage 50, you can create up to 10 ship methods. Since you could set 
up more than 10 shipping methods in DacEasy, the shipping methods 
will be converted as follows:

• If you have 10 or less shipping methods set up in DacEasy, all of 
these will be converted to Sage 50. However, if you have more than 
10 shipping methods, the first 9 will be converted and the ship 
method 10 will be set to Other in Sage 50.
11
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Vendor Information

Most of your vendor information will be converted to Sage 50. However, some 
of the following fields may be shortened if they exceed Sage 50 field limits:

• Vendor name, Address Line 1, Address Line 2, State, and Country

• Contact

Customer Information

The majority of your customer information will be converted, with the 
following exceptions or changes.

• Fields may be shortened: Customer name, Contact name, Address 
Lines 1 and 2, State, and Country fields will be shortened if they exceed 
field limits in Sage 50.

• Price Group: Price Group, or Pricing Level as it is called in Sage 50, will 
be converted according to the following table.

DacEasy Price Group Sage 50 Pricing Level

None Price Level 1

A Price Level 2

B Price Level 3

C Price Level 4

D Price Level 5

E Price Level 6

F Price Level 7

• Salesperson on customer record: If a customer record contains a 
salesperson that does not have a salesperson record in DacEasy, then an 
employee record will be generated in Sage 50 and classified as Sales 
Rep. For more information on salespeople, see “Salesperson 
Information” on page 13.

• Custom fields: You will be asked to select five customer custom fields 
in the Conversion wizard. Custom fields will all be text fields in Sage 50 
and may be shortened if they exceed field limits in Sage 50.
12



Detailed Explanation of What Gets Converted
Sales Tax Information
Sales Tax Information

Most of your sales tax information will be converted, with the following 
exceptions or changes.

• Sales Tax Authorities and Sales Tax Codes: Sage 50 handles sales taxes 
in two separate areas: sales tax agencies and sales taxes. In DacEasy, all 
of the sales tax information is stored in one table. Since all tax codes in 
DacEasy must have at least one liability account, we’ll treat each 
liability account listed in the table as a sales tax agency in Sage 50. 
Unfortunately, we will only be able to convert up to five liability 
accounts per tax code. 

The new tax agency will be named based on the tax code and the row 
number of liability account. For example if the tax code is 5 and the 
table has two liability accounts listed, the new agency IDs in Sage 50 
will be 5-1 and 5-2, respectively.

Salesperson Information

In Sage 50, Salespeople or Sales Reps are set up as employees, allowing you to 
classify a sales rep as either an employee, sales rep, or both. Therefore, all of your 
Salespeople from DacEasy will be converted to employees. We will add “-Sales 
Rep” to the end of the salesperson code to help distinguish salesperson records 
from employee records. For example, if the salesperson code for Betty Brown is 
BB, then the new employee ID in Sage 50 will be BB-Sales Rep.

Inventory Information

Most of your inventory information will be converted with the following 
changes or exceptions.

• Fields may be shortened: The Product Description, Weight, 
Description for substock items, and Warehouse Description for master 
items may be shortened if they exceed field limits in Sage 50.

• Custom fields: You will be asked to select five inventory custom fields 
in the Conversion wizard. All custom fields in Sage 50 are text fields. 
DacEasy custom fields may be shortened if they exceed field limits in 
Sage 50.

• Master and Substock items: Master and substock items will not be 
converted to Sage 50.
13
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• Serialized Inventory: Serialized Inventory is only available in the 
Premium and Quantum lines of Sage 50, which includes the following 
products: Sage 50 Premium Accounting, Sage 50 Manufacturing 
Accounting, Sage 50 Distribution Accounting, Sage 50 Construction 
Accounting, and Sage 50 Quantum Accounting. How will items be 
converted?  

The way that an item will be converted in certain cases will be determined 
by the Sage 50 product that you’re converting to. The following table 
explains how your items will be classified once they are converted to 
Sage 50.

If in Dac DacEasy Item 
Characteristics

Sage 50 Product You’re 
Converting to

New Item 
Classification

1-Normal • No serial numbers

• No components

• No Master item

Sage 50 Premium Accounting

Sage 50 Manufacturing 
Accounting

Sage 50 Distribution Accounting

Sage 50 Construction 
Accounting

Sage 50 Quantum Accounting

Stock

1-Normal or   
3-Negative             

• Has serial numbers

• No components

• No Master item

Sage 50 Premium Accounting

Sage 50 Manufacturing 
Accounting

Sage 50 Distribution Accounting

Sage 50 Construction 
Accounting

Sage 50 Quantum Accounting

Serialized Stock

1-Normal or   
3-Negative             

• No serial numbers

• Has components

• No Master item

All Sage 50 products Assembly
14



Detailed Explanation of What Gets Converted
Inventory Information
• Purchasing/Selling Measure/Fraction : In DacEasy, you could buy and 
sell items in different units according to the purchasing or selling 
fraction that was set up. In Sage 50, buying or selling in different units 
or units of measure is only available in Sage 50 Manufacturing 
Accounting, Sage 50 Distribution Accounting, and Sage 50 Quantum 
Accounting

.     If you are converting to Sage 50 Premium Accounting, your items will 
be converted to the lowest selling or purchasing measure.

• Bill of Materials for Assemblies: In DacEasy, you could enter an 
unlimited number of components for assembly items. You could also 
have serialized items as components in an assembly. Sage 50 does not 
allow unlimited components or serialized items as components. The 
number of components that are allowed is based on the Sage 50 
product that you are converting to. If you are converting to Sage 50 
Manufacturing Accounting,  Sage 50 Distribution Accounting,  or Sage 
50 Quantum Accounting, an assembly can have up to 300 components. 
For Sage 50 Premium Accounting, up to 100 components are allowed. 
When these limits are met during conversion, no more components 
will be added to the assembly.

• Services: All DacEasy Services will be converted and given the item 
class of service in Sage 50. If you had services that had serial numbers, 
these numbers will not be converted because Sage 50 doesn’t allow 
services to be serialized.

1-Normal or   
3-Negative             

• Has serial numbers

• Has components

• No Master item

Sage 50 Premium Accounting

Sage 50 Manufacturing 
Accounting

Sage 50 Distribution Accounting

Sage 50 Construction 
Accounting

Sage 50 Quantum Accounting

Serialized 
Assembly

2- Non-
Inventory

• May or may not have serial 
numbers

• No components

• No Master item

All Sage 50 products Non-stock

If in Dac DacEasy Item 
Characteristics

Sage 50 Product You’re 
Converting to

New Item 
Classification
15
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Jobs Information

Most of your jobs information will be converted with the following exceptions 
or changes.

• Job Defaults: Custom fields that are listed as job defaults may be 
converted if you choose to convert them in the Conversion wizard. If 
the custom field exceeds Sage 50 field limits, it will be shortened.

• Phases and Sub-Phases: All phase and sub-phase information will be 
converted, except Pay Type. Since Sage 50’s Cost Type is not user-
defined, you will be asked to select comparable matches in the 
Conversion wizard.

Payroll Information

Payroll Defaults

Most of your payroll and employee information will be converted with the 
following exceptions or changes:

• Fields may be shortened. The State field will be shortened if it exceeds 
Sage 50’s field limits.

• Custom fields: You will be asked to select five payroll custom fields in 
the Conversion wizard. All custom fields in Sage 50 are text fields. 
DacEasy custom fields may be shortened if they exceed field limits in 
Sage 50.

• Earnings, Deductions, Liabilities: DacEasy allowed you to have an 
unlimited number of earnings, deductions, and liabilities. Sage 50 
limits these options as follows:

• Pay Rates     20

• Deductions/Earnings    40

• Employer Liabilities      40

• Pay Type: DacEasy had three pay types, hourly, salaried, and contract. 
Sage 50 only has two pay methods, hourly and salary. Your pay types 
will be converted according to the following table:

DacEasy Pay Type Sage 50 Pay Method

Hourly Hourly

Salaried Salary

Contract Salary
16



Detailed Explanation of What Gets Converted
Payroll Tax Update Service
• Vacation and Sick time Accruals: Vacation and sick time accruals will 
not be converted. You will be asked to set up calculations for vacation 
and sick time accruals in the Conversion wizard.

Payroll Tax Update Service

If you are a current Tax Update Service subscriber for DacEasy, you will receive 
the equivalent tax updates when you convert to Sage 50. However, the tax tables 
will only be updated after you register your Sage 50 product. Therefore, we 
recommend that you register your Sage 50 product prior to converting your 
DacEasy company. If you do convert before you register, you will need to get a 
tax registration number when you register your Sage 50 product. 
17
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How are Companies Listed in the Open Company window?

DacEasy is a modular accounting system and as such offers a wide variety of 
potential installation configurations. For example, a user may have just the 
Accounting module, or just the Payroll module, or a combination of the two. 
This section will help you understand how your companies will be presented for 
selection in the Open company window.

Let’s start with the Accounting module. If any other module is integrated with 
the Accounting module, the Accounting Company name will be listed. In the 
event that you have two or more payroll companies integrated with an 
accounting company, then the accounting company will be listed several times, 
one time for each payroll company. If you have two or more job cost companies 
integrated with accounting, only the first job company will be eligible for 
conversion.

If you only have Order Entry, Point of Sale, or Payroll, the corresponding 
company names will be listed in the Open Company window.

Finally, Payroll companies that are integrated with Job Cost, but not with 
accounting will be listed separately in the Open Company window.
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Before the Conversion
Before you convert to Sage 50 Accounting, you need to perform the following 
tasks in the Before Conversion Checklist.

Before Conversion Checklist

1 Ship all orders from the Order Entry Module, if needed.

2 Post all transactions from Point of Sales.

3 Post Payroll transactions.

4 Go to Accounting > Posting to post all transactions for each journal.

Posting prior to conversion is paramount to a more accurate conversion.

5 Make sure that any Accounting, Point of Sale, or Order Entry company has a chart 
of accounts set up in DacEasy.

6 If you used Payroll in DacEasy, make sure that at least one department is set up.

7 In DacEasy, print the following reports after all transactions are posted.

• Income Statement

• Balance Sheet

• Trial Balance 

• Chart of Accounts

• General Ledger 

• Customer Directory

• Vendor Directory

• Employee Directory

• Product Activity - This report shows inventory balances if you have 
inventory tracking turned on. If tracking is turned off, create a 
custom report that shows inventory balances by going to 
DacAccess-Query.

• Account Payables/Receivables Aging report 

Some of these reports will be used to verify records and enter information 
into Sage 50 after the conversion. 
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8 Don’t immediately delete DacEasy files! You may want to refer to a transaction or 
other detailed information over the course of the next few weeks as you begin 
using Sage 50 Accounting.

9 Back up all of your DacEasy files. In case you have any problems during the 
conversion, you will want a good backup. See “Backing Up All DacEasy Data 
Files” on page 20 for more information.

10 Register your Sage 50 product.

Note: Don’t immediately delete DacEasy files. You may want to refer to a transaction 
or other detailed information over the course of the next few weeks as you begin using 
Sage 50 Accounting

Backing Up All DacEasy Data Files

Before you begin the conversion process, make a complete backup.

Follow these steps to backup your DacEasy data files.

From the Business Center:

1 Go to Tools > Backup. The Backup Wizard appears.

2 Select the profile and modules you want to back up, and then click Next. The 
default backup location appears.

3 Edit the location if necessary, and click Next. A Summary screen appears.

4 Click Finish to make the backups.

From Modules:

1 Select File > Backup/Restore.

2 Edit the Target field for backup locations, if necessary.

3 Press F10.
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• Converting Sage DacEasy Company 
Data •
Overview

Sage 50 has made it easy for you to convert your DacEasy company data to the 
Sage 50 format. With our easy-to-use Conversion Wizard, most of the work 
associated with conversion is done for you. The DacEasy Conversion Wizard 
guides you through the conversion process. The wizard asks for key information 
about your accounting and costing methods. The wizard also requests default 
purchase and sales account numbers as well as inventory account numbers. The 
accounting information and account numbers that you provide will be used to 
create your new company in Sage 50.
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Starting the Conversion
You can start the conversion in three places in Sage 50: the Sage 50 File menu, 
the Sage 50 Startup screen, and the Open Company window. The easiest way is 
from the File menu. If you are just starting Sage 50 and haven’t opened a 
company yet, you may want to start the conversion from the Sage 50 Startup 
screen. Another way to start the conversion is from the Open Company 
window. Each option is explained below.

From the Sage 50 File Menu
1 To start the conversion, go to File>Convert a Company.

2 Select the DacEasy option and click OK. After you select the DacEasy option, the 
Open Company window appears, displaying only DacEasy companies.

3 Select the company you want to convert and click OK. After you click OK the 
Conversion Wizard appears. Follow the steps of the wizard to begin the conversion 
process. For more information, go to “Using the Conversion Wizard to Convert a 
Sage DacEasy Company” on page 25.

From the Sage 50 Startup Screen

The Sage 50 Startup screen is the first screen that appears after you open Sage 50. 

1 To start the conversion, select Convert from another accounting 
program. The Convert a Company window appears. 
Note: You can also open the Convert a Company window by going to 
File>Convert a Company.

2 Select the DacEasy option and click OK. After you select the DacEasy 
option, the Open Company window appears, displaying only DacEasy 
companies.
23



Converting Sage DacEasy Company Data
Sage DacEasy Conversion Guide2
3 Select the company you want to convert and click OK. After you click OK 
the Conversion Wizard appears. Follow the steps of the wizard to begin the 
conversion process. For more information, go to “Using the Conversion 
Wizard to Convert a Sage DacEasy Company” on page 25.

From the Open Company Window

You can also start the conversion from the Open Company window. Follow the 
steps below to start the conversion from the Open Company window.

1 From the File menu, select Open Company. After the Open Company 
window appears, select DacEasy from the List Companies of Type field.

2 Select the company you want to convert from the list and click OK. After 
you click OK, the Conversion Wizard appears. Follow the steps of the 
wizard to begin the conversion process. For more information, go to 
“Using the Conversion Wizard to Convert a Sage DacEasy Company” on 
page 25.
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Using the Conversion Wizard to Convert a Sage DacEasy Company
After you have selected the DacEasy company that you want to convert to Sage 
50, the Conversion Wizard appears. The wizard will ask you questions about 
your company’s accounting and costing methods. It will also request account 
information for inventory items, customers, and vendors being converted to 
Sage 50. The account information that you select will be used only for the 
records being converted, and not as the defaults for your company. 

Throughout this section, there may be instructions that do not apply to the 
company that you are converting or vary depending on the version of Sage 50 
that you have installed. For example, if you installed Sage 50 Accountant 
Edition, the following window will appear prior to the DacEasy Conversion 
Wizard Welcome window. This window allows you to select the Sage 50 
product that you will be converting this company to. 

Sage 50 Accountant 
Edition Only
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Let’s take a look at the DacEasy Conversion Wizard. The window displayed 
below is the Welcome window. 

1 Read the information on the Welcome window and click Next to continue.

The Company Information window appears.

The company information listed is brought over from DacEasy, so make 
sure the information is correct and make changes where necessary. 

Business Type—Since DacEasy didn’t classify by business type, by default 
all companies are set to corporation. You can change the business type now 
if your business is not a corporation. You can choose from the following 
business types: Corporation, S Corporation, Partnership, Sole 
Proprietorship, or Limited Liability Corporation.

Verify your company information and select a business type. Then, select 
Next to continue.
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2. The Chart of Accounts window appears.

Note: The Chart of Accounts window will only appear if you are 
converting a stand-alone Payroll company. If the company you are 
converting is not a stand-alone payroll company, the Payroll Information 
window will appear. Go to page 28 if the Chart of Accounts window does 
not appear.

Sage 50 requires that you select a chart of accounts even if you are only 
planning to use payroll. You have several chart of accounts from which to 
choose. We suggest that find a chart of account that best matches your 
business. To learn more about a chart of accounts, select (highlight) the 
account in the list and click either the About Your Industry or View Chart 
of Accounts button. 

If you click the About Your Industry button, you will receive information 
about the specific business type that is selected in the Available Charts of 
Accounts window. If you click the View Chart of Accounts button, you will 
be able to view any of the listed charts of accounts prior to selecting one for 
your company.

3 Once you have decided on a chart of accounts, select the account from the 
Available Charts of Accounts list and select Next to continue.
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Note: The Payroll Information window appears only if your payroll 
company is linked to the account company in DacEasy. If you are 
converting an accounting only company, the windows below will not 
appear and you can skip this step. Go to page 29 for further instructions.

Since Sage 50 is a fully-integrated accounting solution, you will be required 
to set up payroll even if you didn’t use it in DacEasy. The information that 
you enter here will be used to set up defaults for records that are converted 
from DacEasy. On this window, you enter information to set up employee 
payroll and vacation and sick time defaults.

Payroll Department and State

Choose the department you use most often—Use the drop-down list to 
select a default department for all of your employees. The departments in 
the list are brought over from DacEasy. When selecting the department, 
choose the one that you used for the majority of your employees in 
DacEasy.

In what state do you pay your employees?—Select the state in which you 
pay most of your employees. The state that you select here will be used as 
the default payroll state in Sage 50.

Vacation and Sick time Accrual

Vacation—In the vacation field, enter the total number of hours vacation 
time an employee can accrue each year. Select the check box if you allow 
unused vacation hours to roll over to the next year.

Sick—In the sick field, enter the total number of sick time (in hours) an 
employee can accrue each year. Select the check box if you allow unused 
sick time to roll over to the next year.
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4 Select your Payroll Department and State defaults and set up vacation and 
sick time accruals, if necessary. Then, click Next to continue.

The Default Accounts and Inventory Costing Method window appears.

This window allows you to select specific default accounts to be used in the 
company you are converting to Sage 50. In addition, you will be asked to 
select a default inventory costing method.

We recommend that you select accounts that you used most often in 
DacEasy as your defaults for Sage 50. By selecting defaults, you can save 
data entry time. Select or enter a default account number for the following 
accounts:

• Sales Account

• Inventory Account

• Cost of Sales Account

• Salary/Wages Account

• Retained Earnings Account

• Expense Account

• Purchase Discount 

• A/R Account

• A/P Account

Note: The accounts that are listed in the look-up list are your accounts 
from DacEasy.
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For the default inventory costing method, you can choose one of the 
following costing methods:

• FIFO (First In, First Out)—Select this method if you want the cost 
determined by assuming that the oldest items are to be sold first.

• LIFO (Last In, Last Out)—Select this method if you want the cost 
determined by assuming that the newest items are to be sold first.

• Average—Select this method if you want the cost determined by the 
average price of all items.

If you had a default costing method set up in DacEasy, a comparable 
default will be selected, but you can change it if you like. If you used 
standard costing in DacEasy, the costing default is set to FIFO.

5 When you have finished making your selections, click Next to continue.

The Custom Fields window appears.

On this window, you will select the custom fields that you want to convert 
from DacEasy. You can select up to five custom fields for customers, 
vendors, and inventory. The fields that you select here will be used as the 
default custom fields for the company that you are converting to Sage 50. 

The majority of the selections in the list come from your user-defined text, 
numeric, and date fields from DacEasy. In addition, we've included some 
fields DacEasy that may not have a comparable counterpart in Sage 50, but 
may include information that you want to convert.
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Select up to five custom fields for each of the following record types:

• Customers

• Vendors

• Inventory

Note: You do not have to make any selections for custom fields if you 
choose. You can select as many or as few custom fields up to 5 for each 
record type.

6 When you have finished making your selections, click Next to continue.

The Custom Fields Part 2 window appears.

On this window, you will select the custom fields that you want to convert 
from DacEasy. You can select up to five custom fields for employees and 
jobs. 

Select up to 5 custom fields for each of the following record types:

• Employees

• Jobs
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7 When you have finished making your selections, click Next to continue.

The Convert window appears.

The Convert window is the final window you will see before the 
conversion process begins. It displays all the options you have chosen in 
the other windows of the Conversion Wizard. 

8 Verify that the information is correct, and then select Convert to begin the 
conversion process. Or, if any of the displayed information is not as 
desired, select Back to return to earlier windows, and then make any 
needed corrections.

After you select Convert, the conversion process begins. Your DacEasy 
company data gets automatically converted to the Sage 50 format. For 
more information about what data gets converted, see “What Gets 
Converted and What Does Not?” on page 3. 
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Once the conversion is complete, the finish window appears.

This is the final window in the DacEasy Conversion Wizard. You have 
successfully converted your DacEasy company to the Sage 50 format. 

9 Select Finish to close the conversion wizard and begin using your Sage 50 
company.
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• What to Do After the Conversion•

Overview
Now that your company has been converted to Sage 50 Accounting, you have the 
final setup work to complete. As mentioned in the previous chapter, the Setup Guide 
is a great place to start when you’re setting up a company. In this chapter, we will use 
the Setup Guide to complete the final setup work for your company. 

If you have further questions, or want more detail about the procedures listed here, 
consult the Sage 50 online Help.
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Using the Setup Guide to Set Up Your Company
After the conversion is complete, the Setup Guide will appear. The Setup Guide 
presents a comprehensive outline of how to set up your company. While some of the 
steps were completed during conversion, like entering vendor, customer, item, and 
employee records, we suggest that you follow the Setup Guide step-by-step. When 
the Guide suggests that you add records, you should verify that all of your data 
records converted properly. 

The Setup Guide is shown below.

Each area of setup is 
listed. Click the area to 

walk through the steps of 
setting up that part of 

Sage 50.

You may not need to set up each area of Sage 50 for your company. For 
example, if you don’t use Inventory, then you should skip that section of this 
chapter.

You can reopen the Setup Guide at any time by going to File, Setup Guide.
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Setting up Customers

The Customers page of the Setup Guide helps you set up Sage 50 to track amounts 
owed to you by customers for items or services you sold to them. You can open this 
page by clicking the Customers link on the Setup Guide page.

As mentioned earlier in this guide, the conversion may have already completed 
some of the steps listed. Let’s take a look at the steps needed to set up your 
customers.

1 Set up Your Customers

On the opening screen, select Yes, I want to enter customers now and then 
click Next. The new screen will display a list of existing customers, if any. Scroll 
through this list and make sure that all of your customers appear. If so, select 
Next to continue to the next step. If not, click Add New Customer to open the 
Maintain Customers window. In the Maintain Customers window, you can 
enter, change, and store information about companies and people you sell 
goods and services to. You can also enter information about companies and 
people you would like to do business with (prospects). Information about 
customers is stored on different tabs. Click a tab to enter the additional 
customer information. When you have finished adding any customers, close 
the Maintain Customers window and you will return to the Customer Setup 
Page. Click Next.
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If you printed the Customer Directory Report from DacEasy, use it to compare 
and verify the customer information that was converted to Sage 50.

2 Enter Your Customer Beginning Balances

In this step, verify that your beginning balances from DacEasy converted 
properly. Select Yes and click Next. Then click Enter Customer Beginning 
Balances. If you need to change information, select the customer name on the 
Customer Balances tab; then enter amounts for outstanding invoices on the 
Invoices from tab.

Tip: You can use the Customer Directory Report from DacEasy to compare and 
verify your customer beginning balances.

When you are done, close the Customer Beginning Balances window and select 
Next on the Customer Setup page.

3 Select Your Customer Defaults

Sage 50 will display the current customer defaults for you. If you do not need to 
change them, click Next. If you want to make changes, click Change Customer 
Defaults. In the Customer Defaults window, you can set up default information 
for customers. You enter the most common information. Then, when you set 
up new customers and enter transactions, the default information is 
automatically included. 

The Customer Defaults window has five tabs:

• Payment Terms—On this tab, you set up default (standard) payment 
terms for your customers and default sales and discount G/L accounts.

• Account Aging—On this tab, you set up how sales invoices are aged and 
what aging brackets will be used for accounts receivable.

• Custom Fields—On this tab, you set up custom field names for your 
customer records. This information is brought over during the 
conversion. Verify that the custom fields are correct.

• Finance Charges—On this tab, you set up when and how finance 
charges are calculated for your customers.

• Pay Methods—On this tab, you set up payment methods for your 
customers or deposit ticket ID properties.

For more information about what to enter on the tabs in this window, select the 
Help button.

When you are done, close the Customer Defaults window and click Next on the 
Customer Setup Page.

4 Create Sales Taxes
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Your sales tax information should have converted from DacEasy properly. However, 
if you want to verify it, select Yes, I collect Sales Tax from my customers. Then click 
Next. Sage 50 will walk you through three steps of sales tax setup. You can use the 
lists to verify the completeness of the information. If you need to add sales tax 
vendors, sales tax agencies, sales taxes, or assign sales taxes to customers, you can do 
so from the setup.

If you do not need to verify sales taxes, click Next. 

5 Select Your Statement and Invoice Defaults

The Customer Setup page will show you the current statement and invoice 
defaults. If you are satisfied with these, click Next to continue. Otherwise, click 
Change Statement and Invoice Defaults. This will open the Statements/Invoices 
Defaults window. In this window, you set up default information for printing 
customer statements and sales invoices. These options let you customize your 
customer statements and invoices including print options and dunning 
messages. The defaults you enter here are used throughout Sage 50. 

Select the information desired on the Statement Print Options tab, then select 
the Dunning message tab to enter text for dunning messages. If you are not sure 
what to select or enter on either of these tabs, click Help for more information.

When you are done, close the Statement and Invoice Defaults window and click 
Next. Select one of the options to continue.
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Setting up Jobs

The Jobs page of the Setup Guide helps you set up Sage 50 to track all the costs and 
revenues associated with a specific project. You can open this page by selecting Jobs 
from the Setup Guide main page.

Select Yes, I want to enter jobs now and click Next to get started. As mentioned 
earlier in this guide, the conversion may have already completed some of the steps 
listed. Let’s take a look at the steps needed to set up your jobs.

1 Set Up Jobs

Any jobs that were converted will appear in the list on the screen. Verify that 
this list is complete and click Next if you do not need to create any jobs now. 
Otherwise, click Add New Job to add a new job. This will open the Maintain 
Jobs window. In the Maintain Jobs window, you can track the costs associated 
with the completion of a job or project. These can include expenses associated 
with purchasing materials or paying for labor, equipment, or subcontractors. 
Information about jobs is stored on three different tabs. Click the tab to view 
the additional job information.

Also, if there is information that you want to add to the job item record, enter it 
as you verify your records. Use the Back or Next (arrow) buttons next to the Job 
ID field to go to the previous or next record. Be sure to verify data on every tab 
for each job.

When you are done, close the Maintain Jobs window and click Next on the Job 
Setup page. 
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2 Enter your Jobs Beginning Balances

Since Sage 50 and DacEasy handle jobs differently, none of your beginning 
balances were converted. You will have to enter them manually.

On the window, select Yes if you want to enter beginning balances for your jobs now. 
Select one of the other options if you do not. Then click Next. If you selected Yes, 
follow the steps to enter your job beginning balances. To enter job beginning 
balances, select the job name on the Job Balances tab; then enter dates and amounts 
for expenses and revenue on the Job Entries for tab. Repeat this step for all of the jobs 
that were converted from DacEasy.

When you have finished, close the Jobs Beginning Balances window and click Next 
on the Job Setup page.

3 Select Your Job Defaults

If you want to set up custom fields, click Change Job Defaults. In the Job 
Defaults window, you can set up custom field names for your job records. 
Custom fields offer you a way to keep track of specific information about the 
people who supply you with goods and services. We have provided some 
common custom field names; however, you may change them to better suit 
your business needs.

When you are done, close the Job Defaults window. Note that if you want to 
enter specific information for these custom fields for each job, you must reopen 
each job record and add the information. The field labels will appear but not 
the information specific to each job. 

Click Next to proceed to the next setup area.

Setting up Vendors

The Vendors page of the Setup Guide helps you set up information for balances you 
owe to vendors for good, supplies, and services that you’ve purchased. You can open 
this page by clicking Vendors from the Setup Guide. 
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As mentioned earlier in this guide, the conversion may have already completed 
some of the steps listed. Let’s take a look at the steps needed to set up your 
vendors.

1 Set up Your Vendors

If you want to add vendors or check that all of your vendors converted properly, 
select Yes, I want to add vendors now; then, click Next. The next screen will 
show you the vendors that transferred. Examine this list. If it is complete, click 
Next to continue to the next step. If not, click Add New Vendor to open the 
Maintain Vendors window. In the Maintain Vendors window, you can enter, 
change, and store information about the companies and people you purchase 
goods and services from. Information about vendors is stored on different tabs. 
Click a tab to view the additional vendor information.

If there is information that you want to add to the vendor record, for example 
an e-mail or Web address, enter it as you verify your records. Use the Back or 
Next (arrow) buttons next to the Vendor ID field to go to the previous or next 
record.

If you printed the Vendor Directory Report from DacEasy, use it to compare 
and verify the vendor information that was converted to Sage 50.

When you have finished adding vendors, close the Maintain Vendors window and 
click Next on the Vendor Setup page.
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2 Enter Your Vendor Beginning Balances

In this step, verify that your beginning balances from DacEasy converted properly. 
You can do this by selecting Yes and then clicking Next. On the new page, click Enter 
Vendor Beginning Balances. If you need to change information, select the vendor 
name on the Vendor Balances tab; then enter amounts for outstanding invoices on 
the Purchases from tab.

When you are done, close the Vendor Beginning Balances window and click Next on 
the Vendor Setup page. 

3 Select Your Vendor Defaults

The Setup Guide displays the current vendor defaults. If these are acceptable, 
click Next to continue to the next part of the Setup Guide. Otherwise, click 
Change Vendor Defaults to open the Vendor Defaults window. In the Vendor 
Defaults window, you can set up default (common) information for vendors. 
Enter basic setup information that applies to most of your vendors and 
purchases. Then, when you set up new vendors and enter transactions, the 
default information is automatically included. This can save a great deal of time 
during data entry.

The Vendor Defaults window has four tabs:

• Payment Terms—On this tab, you set up default (standard) payment 
terms for your vendors and default purchase and discount G/L accounts.

• Account Aging—On this tab, you set up how purchase invoices are aged 
and what aging brackets will be used for accounts payable.

• Custom Fields—On this tab, you set up custom field names for your 
vendor records. This information is brought over during the conversion. 
Verify that the custom fields are correct.

• 1099 Settings—On this tab, you establish how 1099 calculations will be 
made for each of the general ledger accounts in your chart of accounts.

For more information about what to enter on the tabs in this window, select the 
Help button.

When you are done modifying vendor defaults, close the Vendor Defaults 
window and click Next on the Vendor Setup page.
44



Using the Setup Guide to Set Up Your Company
Setting up Inventory
Setting up Inventory

The Inventory page of the Setup Guide helps you set up Sage 50 to track the quantity 
(value) of goods on hand and available for sale. You can open this page by clicking 
Inventory on the Setup Guide.

As mentioned earlier in this guide, the conversion may have already completed some 
of the steps listed. Let’s take a look at the steps needed to set up your inventory.

1 Set up Your Inventory Items

If you want to verify that your inventory converted properly, select Yes, I want 
to enter inventory and service items now; then click Next. Sage 50 will list the 
items that converted. Examine this list to make sure that everything converted. 
If you do not need to make any changes, click Next to continue to the next 
screen. If you must add items or change information, click Add New Item or 
Service. This will open the Maintain Inventory Items window. In the Maintain 
Inventory Items window, Sage 50 tracks the inventory items you buy and sell 
and automatically updates the quantities after each posted transaction. 
Information about inventory items is stored on different tabs. Click a tab to 
view the additional inventory item information.

Note: Quantity on Hand amounts did not get converted from DacEasy. You can 
either enter them by clicking the Beginning Balances button on this window or 
in the next step when we enter beginning balances.
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If you printed the Product Listing Report from DacEasy, use it to compare and 
verify the inventory item information that was converted to Sage 50.

When you are done, close the Maintain Inventory window and click Next.

2 Enter Inventory Beginning Balances.

As mentioned earlier, the quantity-on-hand for inventory items did not get 
converted from DacEasy. You will need to enter these quantities manually for 
each inventory item.

Select Yes on the window and click Next. Then click Enter Inventory Beginning 
Balances. This will open the Inventory Beginning Balances window. Beginning 
Balances for inventory items includes the quantity, unit cost, and total cost of 
the inventory. 

Select an item from the list and enter the quantity and the unit cost. The total 
cost will be calculated automatically. Repeat this step for all inventory items.

When you have finished, close the Inventory Beginning Balances window and 
click Next.

3 Select Your Inventory Defaults

Sage 50 will show you the current inventory defaults. If these are acceptable, 
click Next. If not, click Change Inventory Defaults. This will open the Inventory 
Defaults window. In the Inventory Defaults window, you can set up default 
information for inventory items. You enter the most common information. 
Then, when you set up new inventory items and enter transactions, the default 
information is automatically included. 

The Inventory Defaults window has six tabs:

• General—On this tab, you make basic choices about how inventory 
items will be handled in Sage 50.

• Ordering--Use this tab to specify how Sage 50 will handle out of stock 
situations.

• GL Accts/Costing—On this tab, you set up the default or most common 
General Ledger accounts for each item class in inventory.

• Taxes/Shipping—On this tab, you set up default tax type categories and 
shipping methods for your inventory items.

• Custom Fields—On this tab, you set up custom field names for your 
inventory item records.

• Price Levels—On this tab, you set up sales price levels for your items. 
Price levels offer you a way to charge different prices to different 
customers.
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When you have finished, close the Inventory Defaults window and click Next. 

Setting up Employees

After the conversion, Employees is the area in Sage 50 where you will have to do the 
most setup work. Since Sage 50 handles payroll differently than DacEasy, much of 
your payroll information did not get converted, including beginning balances. 

The Employees page of the Setup Guide will help guide you through the process of 
setting up your employees. You can open this page by clicking the Employees link 
on the Setup Guide.

1 Select the initial payroll option

If you don’t use payroll or employees at all, you can select I don’t plan to use Sage 
50 for payroll or I want to skip this for now. If you want to set up Sage 50, select In-
house payroll, where I do payroll within Sage 50. The Sage 50 Payroll Service 
option will lead you to screens, where you can sign up to have your payroll handled 
by Sage 50 Payroll Services.

On the next screen, select Run Payroll Setup Wizard. This wizard will walk you 
through the setup of your state taxes, vacation and sick time, and 401k plans. 
Most of the setup information here will have converted, but you can follow the 
steps of the Payroll Setup Wizard to check it. Then you can return to the 
Employee Setup page. Click Next to move to the next step.

2 Set up Your Employees
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Select Yes, I want to enter employees now to display a list of the employees 
that converted from DacEasy. Review the list and click New Employee or Sales 
Rep if the list is incomplete. If you click this option, you will open the Maintain 
Employees/Sales Reps window. In the Maintain Employees/Sales Reps window, 
you can enter, change, and store information about your company employees 
and sales reps. Information about employees or sales reps is stored on different 
tabs. Click a tab to view the additional employee information.

If you printed the Employee Directory Report from DacEasy, use it to compare 
and verify the employee information that was converted to Sage 50.

When you have finished, close the Maintain Employees window and click Next 
on the Employee Setup page.

3 Enter your Employee Beginning Balances

Employee beginning balances do NOT convert, so you must perform this step 
if you are starting to use Sage 50 in the middle of the year and have outstanding 
annual amounts for each employee. Select Yes on this page and click Next. 
Then, click Enter Employee Beginning Balances. This will open the Employee 
Beginning Balances window. Entering your employee beginning balances 
correctly ensures that your monthly, quarterly, and year-end reports will print 
correctly. You can enter a beginning balance for each employee and edit it at 
any time—it does not affect the general ledger. We suggest that you enter 
beginning balances for employees before entering any payroll transactions.

To enter a beginning balance for an employee, click the magnifying glass 
(lookup) button next to Employee ID field. Then, select an employee. Set up 
dates for the balances you're going to enter. You can enter up to 52 dates for 
paychecks or you can enter quarterly dates, so that quarterly reports and W-2s 
will compute properly. 

Note: when you are entering dollar amounts, you should enter earnings as 
positive dollar amounts and deductions as negative dollar amounts. Check the 
Net Check value at the bottom of each column to make sure you have entered 
everything correctly.

When you have finished entering beginning balances for an employee, click the 
Save button and then select another employee. When you have finished 
entering the beginning balances, close the Employee Beginning Balances 
window. Then, click Next on the Employee Setup page.

4 Select Your Employee Defaults
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This page will display the employee defaults, such as pay levels and custom 
fields, that converted from DacEasy. If you want to make changes, click the 
Change Employee Defaults button. This will open the Employee Defaults 
window. In the Employee Defaults window, you can set up default (common) 
information for employees. Enter basic setup information that applies to most 
of your employees and payroll transactions. Then, when you set up new 
employees and enter paychecks, the default information is automatically 
included. This can save a great deal of time during data entry.

The Employee Defaults window has three tabs:

• General—On this tab, you set up basic default information for your 
employees, including a locality and custom field names. Custom field 
names are brought over during the conversion. Verify that they are 
correct. Some names may be shortened because of field limits in Sage 
50.

• Employee Fields—On this tab, you set up defaults for how Sage 50 
handles employee-paid taxes and other deductions.

• Company Fields—On this tab, you set up defaults for how Sage 50 
handles employer-paid taxes and contributions.

• Review Ratings—On this tab, you set up performance review ratings 
that your company uses when rating or reviewing employees.

• Employment Status—On this tab, you set up employment statuses for 
your employees. Some statuses have been provided for you. You can 
customize these statuses by editing the existing statuses and adding new 
ones.

For more information about what to enter on the tabs in this window, select the 
Help button.
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Setting up Chart of Accounts

You can open the Chart of Accounts page of the Setup Guide by clicking the Chart 
of Accounts link on the Setup Guide.

To start, click Next. Let’s take a look at the steps needed to set up your general ledger. 

1 Set up Your Chart of Accounts

The first page will display the chart of accounts that converted. Examine this 
list and make sure that all of your accounts are present. If they are, click Next to 
continue to the next step. If not, click Add New Accounts. This will open the 
Maintain Chart of Accounts window. The Maintain Chart of Accounts window 
is used to:

• add a new account

• define an account type

• modify the description of an existing account

• delete an account

Note: select Budgets from the Maintain menu to view your budget information.

When you are satisfied, click Next on the Chart of Accounts setup page.
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2 Enter your Account Beginning Balances

Instead of entering G/L Account Balances, you should verify the general ledger 
account balances that were converted from DacEasy. Select Yes on this page and 
click Next. Click Enter Account Beginning Balances. Then select a period to 
display. This period should be the period just prior to when you will begin 
entering transactions in Sage 50. After you select a period to display, the Chart 
of Accounts Beginning Balances window will appear. If any information is 
incorrect, update the beginning balances with the correct information.

When you have finished, close the Chart of Accounts Beginning Balances 
window and click Next on the Accounts Setup page.

If you prefer to verify your information by report only, you can compare the 
General Ledger Report from DacEasy with the General Ledger Report from 
Sage 50. When you are comparing reports, make sure that you are comparing 
the same period. To print the General Ledger Report in Sage 50, select General 
Ledger from the Reports & Forms menu. Then, double-click the General 
Ledger Report in the Report list. Select the Print button to print the report.

3 Select Your General Ledger Defaults

On the defaults page, you will see the Rounding Account listed. This was part of 
the conversion. If you want to change that account, click Change General 
Ledger Defaults. Select the Rounding Account tab and enter a different 
account.

Since Sage 50 has the ability to round financial statements either to whole 
dollars or to whole thousands of dollars, an account is needed to collect the 
rounding difference when you choose to round totals. The rounding account is 
used by Sage 50 to store rounding differences for financial statements; it can be 
either a balance sheet account or an income statement account. However, we 
recommend that you use a Retained Earnings account.

When you have finished, close the General Ledger Defaults window and click 
Next on the Chart of Accounts Setup page. 

Setting up User Security

The last step of setting up Sage 50 is to create users and passwords. This step is not 
necessary, so if you will not be setting up different users, you have finished the Setup 
Guide.

To create users, select User Security from the Setup Page.
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1 Set Up Users

On the User Security page, you will see a list of users, if any. To set up users, 
select Yes, I want to set up users now. Then click Next.

On the new page, click Set Up Users. This will open the User Security window. 
Use this screen to create user IDs, passwords, and access rights to different 
parts of the program. 

When you have finished, close the User Security window and click Next on the 
User Security Setup page. If you want to see what you could do next, click Show 
me what I might do next and click Next.

Now that you have completed the setup work for Sage 50, you can begin using Sage 
50 to enter transactions. We suggest that you review the online Help to learn more 
about how things work in Sage 50.
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